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New features of Domino 6.0.1:  Single 
Copy Template

In previous releases of Domino™, when you created a database from an existing template 
(.ntf), the newly created database stored all the design elements into individual .nsf files. If 
you needed to create several databases using the same template, you had to store multiple 
instances of the same design information within each database. One of the concerns of 
administrators maintaining Domino infrastructures is the cost of disk storage.

Lotus® Domino 6.0.1 introduces a new feature called Single Copy Template (SCT), which will 
allow administrators to conserve a considerable amount of storage space. When SCT is 
enabled in a template, it results in the replacement of design elements in the inheriting 
databases on the same server with pointers or reference notes. These reference notes point 
to the associated design element in the template in a fashion that is transparent to the end 
user. In this way, design notes are stored only once on the server. 
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Functionality of the Single Copy Template
Figure 1 illustrates on a high overview level how Single Copy Template works. 

Figure 1   Overview of SCT functionality

Each Domino database that inherits from a template with SCT enabled does not store its 
design in the .nsf file, but instead, retrieves the design from the SCT enabled template each 
time that a request for a design element is sent to the server. For this reason, the SCT feature 
only works on a Domino server, not on a local workstation. Locally, all design elements are 
stored on the workstation, therefore, the size of your local database will be different from the 
server's replica if SCT is enabled. Therefore, replicating a database, which inherits from a 
SCT enabled database to your local workstation, results in the replication of the actual design 
elements to the local replica from the template.

Figure 2   File size differences

Figure 2 shows database properties for two replicas of the same database. The database on 
the left is a local replica, and therefore contains all the design elements; the database on the 
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right is on a Domino server and is set to inherit from a SCT enabled template. Notice the 
difference in file size.

Any modification of a design element in a database inheriting from a single copy template will 
result in a full copy of that design element to be copied into the database. The use of SCT 
does not prevent the users from doing their own customization, such as creating a private 
folder or a view. The changes will be in the local database, and they will be replicated back to 
the server-based replica. 

Enabling Single Copy Template
Single Copy Template is a server feature that works only on a Domino 6.0.1 (or later) server 
using ODS 43 for both the template and the database. ODS is the internal database structure; 
SCT property is not replicated to others servers. If you replicate with a Domino R5 server or 
with a Domino 6 server that does not use SCT, the replicated files will contain all the design 
elements. 

Any template that meets these requirements is eligible for use with SCT. There is no 
relationship between the content of the template itself and the possibility of using SCT, 
therefore, a template such as mail50.ntf (R5 Mail template) can be deployed on a Domino 6 
server using Single Copy Template functionality.

Any standard template that ships with Domino can be enabled for SCT, but we suggest using 
your own set of templates, which have a different file name, template name, and replica ID 
than the standard ones. If you do this, it will help you when you upgrade your server later. 
Your templates will not be deleted or overwritten during the upgrade process as they will have 
different file names. Furthermore, using a different template name will prevent having several 
templates claiming to be the reference.

Table 1   Example of existing templates 

Activating SCT on a template
This section describes the steps to activate the SCT feature on your template:

1. Identify the template that you want to enable for SCT: 

– If you do not have a specific template, you can create a specific new template as 
shown in Figure 3.

Database title File name Template name

Mail (R6) Mail6.ntf StdR6Mail

Mail (R5.0) Mail50.ntf StdR50Mail

iNotes™ Web Access (R6.0) inotes60.ntf iNotes60

iNotes Web Access (R5) inotes5.ntf iNotes5

TeamRoom (R5) Teamrm6.ntf StdR50TeamRoom

TeamRoom (R6.0) Teamrm50.ntf StdR6TeamRoom
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Figure 3   Creating a new template

– If you already have your own existing template, use that template.

2. Using your Domino Administrator client, open the database properties for the database 
you want to enable for SCT, and go to the fourth tab or the Design tab. 

3. Select Database file is a master template file and specify a template name; for example, 
Mail6SCTEnabled. 

4. Select Single Copy template.

Figure 4   Enabling SCT on template
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Deploying Single Copy Template 
In order to deploy Single Copy Template you have three options: 

� Enable SCT on the databases that already inherit the design of the template.
� Activate Single Copy template on specific databases.
� Enable SCT on an existing template that is being used for inheritance.

Enable SCT on the databases that already inherit design of the template
These are the steps:

1. Using your Domino Administrator 6 client, you can list all the databases with the 
information about the specific templates they inherit from. Open your server, go to the 
Files tab, select the folder containing your databases, and make note of the Template 
column. Notice that you can click the column headers to sort the database list.

Figure 5   Listing databases with information about template inheritance
 New features of Domino 6.0.1: Single Copy Template 5



2. From the server console, issue the load convert command to replace old template 
names with the new one. The syntax of the command is as follows:

– >load convert <directory>\*.nsf <current template name> <Single copy template 
file namename> 

In our example the command is: 

>load convert mail/*.nsf StdR50mail mail6SCTon.ntf

The server console then shows lines like the following:

>03/05/2003 10:49:16 PM  Mail Conversion Utility starting
>03/05/2003 10:49:16 PM  Mail Convert: Started replacing design template 
'StdR50mail' with 'Mail6SCTenabled' in 'mail/jkoval.nsf'
>03/05/2003 10:49:16 PM  Updating 'ACLManagement' into database 'Jean Noel Koval 
Mail file' from template 'Mail 6 with SCT enabled' 
>show task 
>Mail Upgrade         Replacing design template in mail/mail42.nsf

3. When the Mail Conversion Utility completes, all the listed databases have been set to 
inherit their design from the template that we enabled for SCT. For more details about the 
convert task, please refer to the Domino 6 administration help database.

Tip: Columns displayed in the File tab are customizable. You can select which column and 
in which order you want to display them. 

To do so from your Domino Administrator client, go to File -> Preferences -> 
Administration Preferences and select the Files tab. 

You will need to restart your Domino Administrator client in order for your changes to have 
an effect.
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Figure 6   Databases that have been converted with mail file utility program

4. The next step is to run the design task. The design task will delete all design elements 
from your database, and will replace them with the virtual reference to the design 
elements in the Single Copy Template. By default, this task will run automatically at 1 AM 
every day, but you can schedule a program document to run this task at a desired time, or 
invoke it from your Domino server console by typing: 

>load design

5. The final task is to run the compact task to recover space freed by the design elements that 
are no longer stored in your databases. You can run this command directly from a server 
command console: 

>load compact 

or from a program document. An exemplary program document is shown in Figure 7.

Figure 7   Running compact from a server program document

Here is an excerpt from the log database after the compact task ran on the databases that 
had just had been converted to use SCT:

Tip: A new feature in the Lotus Domino 6 allows you to specify arguments when using 
the design task. For example, if you want to run the design task against a specific 
directory (mail in our example), issue the following command: 

>load design -d mail
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03/06/2003 07:00:51 AM  Running Program document for 'compact'
03/06/2003 07:01:26 AM  Compacting mail/jkoval.nsf (Jean Noel Koval Mail file)
03/06/2003 07:01:43 AM  Compacted  mail/jkoval.nsf, 3584K bytes recovered (56%)
03/06/2003 07:01:43 AM  Compacting mail/mail100.nsf (mail 100)
03/06/2003 07:01:59 AM  Compacted  mail/mail100.nsf, 3584K bytes recovered (66%)
03/06/2003 07:01:59 AM  Compacting mail/mail10.nsf (mail 10)
03/06/2003 07:02:14 AM  Compacted  mail/mail10.nsf, 3840K bytes recovered (68%)
03/06/2003 07:02:14 AM  Compacting mail/mail11.nsf (Mail 11)
03/06/2003 07:02:30 AM  Compacted  mail/mail11.nsf, 3840K bytes recovered (68%)
03/06/2003 07:02:30 AM  Compacting mail/mail12.nsf (Mail 12)
03/06/2003 07:02:46 AM  Compacted  mail/mail12.nsf, 3584K bytes recovered (66%)
03/06/2003 07:02:46 AM  Compacting mail/mail13.nsf (Mail 13)
03/06/2003 07:03:01 AM  Compacted  mail/mail13.nsf, 3584K bytes recovered (66%)
03/06/2003 07:03:01 AM  Compacting mail/mail14.nsf (Mail 14)
03/06/2003 07:03:17 AM  Compacted  mail/mail14.nsf, 3328K bytes recovered (61%)
03/06/2003 07:03:17 AM  Compacting mail/mail15.nsf (Mail 15)
03/06/2003 07:03:33 AM  Compacted  mail/mail15.nsf, 3840K bytes recovered (68%)
03/06/2003 07:03:33 AM  Compacting mail/mail16.nsf (Mail 16)
03/06/2003 07:03:48 AM  Compacted  mail/mail16.nsf, 3840K bytes recovered (68%)
03/06/2003 07:03:48 AM  Compacting mail/mail17.nsf (Mail 17)
03/06/2003 07:04:03 AM  Compacted  mail/mail17.nsf, 3840K bytes recovered (68%)
03/06/2003 07:04:03 AM  Compacting mail/mail18.nsf (Mail 18)
03/06/2003 07:04:16 AM  Compacted  mail/mail18.nsf, 3840K bytes recovered (68%)
03/06/2003 07:04:16 AM  Compacting mail/mail19.nsf (Mail 19)
03/06/2003 07:04:31 AM  Compacted  mail/mail19.nsf, 4096K bytes recovered (72%)
03/06/2003 07:04:31 AM  Compacting mail/mail1.nsf (mail 1)
03/06/2003 07:04:45 AM  Compacted  mail/mail1.nsf, 3840K bytes recovered (71%)
03/06/2003 07:04:45 AM  Compacting mail/mail20.nsf (Mail 20)
03/06/2003 07:05:00 AM  Compacted  mail/mail20.nsf, 3840K bytes recovered (68%)

When the compact is finished, you will see that the size of the newly converted files have 
been reduced by almost the full size of the design elements. Figure 8 shows the results of our 
exemplary mail databases. The average file size before enabling SCT was about 13 Mb, and 
after enabling SCT 1.7 Mb.

Attention: If you use transactional logging, and if you want to recovery free space, you will 
need to run compact with -B switch: 

> load compact -B 

Alternatively, you can specify a directory upon which to run the compact task:

> load compact -B mail

Please be aware that running compact with this switch will change your Database Instance 
Identifier (DBIID). This means that if you use an incremental backup software, you will need 
to run a full backup immediately after running compact with this switch.

When using transactional logging, compact runs by default with -b (in lowercase) switch, 
which recovers space without reducing file size. Please note that this is different than using 
the -B (uppercase) switch.
8 New features of Domino 6.0.1:  Single Copy Template



Figure 8   Comparison of file sizes before and after enabling SCT 

Now, each time that a user opens his database, required design elements will be retrieved 
from the Single Copy Template database and showed to the user. Figure 8 shows Domino 
console with exemplary entries indicating that design elements were retrieved from the SCT 
enabled template (only visible if you have turned on the debugging parameter).

Figure 9   Design elements sent by the server

SCT is completely transparent to the end user. The end user will still be allowed to modify any 
design elements, create views and folders, and more.

When a user modifies a common design element, this modified element is unlinked from SCT, 
and copied back into the user’s database (both on the server and locally on the user’s 
workstation). Opening the database with Domino Designer® will display all design elements 
as they are physically in the database.

Important: Running compact task is not mandatory as SCT will be available just after 
running the design task. 

The compact task recovers free space in your databases, which is why you will most 
probably want to run it.
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Figure 10   Showing a database design in the Domino Designer

Activate SCT on specific databases only
Under certain circumstances, you may have databases which do not inherit from a template, 
therefore, the design task will not affect these databases:

1. If you want to use SCT on these database, it is mandatory to activate design inheritance. 
The easiest way to do this is to use the convert server task as explained previously, 
although the syntax will be a little different: 

>load convert <directory where your files are>\*.nsf *(wildcard) <Single Copy Template 
File name>

In our example the syntax is: 

>load convert mail/*.nsf * Mail6SCTon.ntf 

The Convert task will replace design information for all databases under the mail directory, 
regardless if it has design inheritance previously set or not.

Attention: If you have replicated databases on different servers (for example, in a 
clustered environment) and you run design task on these servers, you will get error 
messages in these server logs indicating that the design task is unable to locate templates. 
However, the database will work on both servers.

This is to be expected. You can replicate this new template onto all servers in the cluster, 
but be aware that if you want to enable SCT on other servers (for the same databases) you 
will need to activate the SCT option on the database that is on the targeted server. The 
SCT database option is not replicated to avoid running SCT when it was not intended.
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2. Load the design task to load the new design, as described in step 4 on page 7.

3. After the design task has finished running, run the compact task to recover space freed by 
design elements that are no longer stored in your databases. See step 5 on page 7 for 
instructions on how to run the compact task.

Enabling SCT on an existing template already used as design reference
In this case, enabling SCT is as simple as selecting Single Copy Template in your template’s 
database properties.

Next time the design task will run, the databases that are set to inherit from this template 
inherit the design, and the design elements are replaced with references to the SCT enabled 
template.

If your template and databases are replicated on others servers, this property is not 
replicated, and you will have to turn it on for each replica separately on the different servers.

Turning off Single Copy Template
If you have changed design inheritance and want to go back to the original design:

� Run the convert utility to revert to original template inheritance: 

– load convert <directory to convert>\*.nsf <SCT template name> <previous 
template file name> 

>load convert mail\*.nsf Mail6SCTenabled Mail6.ntf

– Run the design task to replace the design of the databases and to recover all design 
elements. 

If you have used an existing template: 

� You just need to unselect the Single Copy Template property from the template’s database 
properties and run the design task to replace the design of the databases and to recover 
all design elements. 

Tip: Before you launch a large conversion you may want to know ahead of time which 
databases will be converted. You can run the convert task with the -n parameter to 
show which databases will be affected by running the task.

>load convert -n mail/*.nsf * Mail6SCTon.ntf 
03/07/2003 02:44:07 PM  Mail Conversion Utility starting
03/07/2003 02:44:07 PM  Mail Convert: Use of -n option will not replace design 
template or convert categories to folders
03/07/2003 02:44:07 PM  Mail Convert: Utility will affect the following database(s) 
when -n option is omitted
03/07/2003 02:44:07 PM  Mail Convert: mail/jkoval.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail5.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail13.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail20.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail37.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail21.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail25.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail26.nsf
03/07/2003 02:44:07 PM  Mail Convert: mail/mail17.nsf
03/07/2003 02:44:07 PM  Mail Conversion Utility shutdown
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Considerations
Even if Single Copy Template is a powerful feature, some considerations need to be given on 
the following areas:

� When you create your Single Copy Template database, you can specify other database 
properties, which will be applied to all your databases. Make sure that the database 
properties you have selected for the template are the ones you want to enable for the 
databases. The databases inheriting from the template also inherit the database 
properties of the template.

Figure 11   List of database properties

� You cannot replace the design of the database which stores all the design elements using 
your Notes® client. If you want to modify a design element to apply it to all the databases 
which use SCT, you need to use with the Domino Designer client to edit the design 
element. If you try to replace the design of the database marked as SCT, you will get this 
error in Figure 12.

Figure 12   Unable to locate design elements

� All users who have designer or manager access to the database can replace the design of 
the database. This replace can be done either locally (on their workstation and then 
replicated back to the server) or directly on the server-based replica. To avoid this 
situation, your users should have editor access only. In addition, if a change has been 
made to the design of the database, the change will be overwritten the next time that 
design will run on the server, and then will be replicated to the local databases unless you 
prohibit design refresh or replace for these elements.
12 New features of Domino 6.0.1:  Single Copy Template



� Do not change the name of the Single Copy Template since databases that have a 
reference to the SCT will lose their association, and you will not be able to open the 
database.

Performance impact of Single Copy Template
In order to quantify the performance impact of using SCT, we ran internal tests to identify the 
benefits of using SCT compared to the same server running the equal load without SCT. 
Tests were performed on the Windows 2000 platform. Data on the following areas was 
collected:

� Amount of disk usage
� Disk load (% read and % write time) 
� CPU usage
� Memory usage

To simulate the load, we used the following hardware:

Domino server, Windows
� IBM® Netfinity® 5500 PII 400 

� 512 Mb RAM (cache L2 256 kb) 

� Disk subsystem SCSI with two arrays (c:\ for OS, paging & Domino binaries, 
and D:\ for data) both on RAID 0 

� Windows 2000 AS Service Pack 3

� Domino 6.0.1 Server

Domino server, Linux
As Linux and Windows 2000 can run on the same hardware, we conducted another test on 
the Linux platform (Linux distribution was UnitedLinux 1.0) using the same physical machine 
as for the Windows 2000 tests. In this case, we should be able to compare results between 
the two tests:

� IBM Netfinity 5500 PII 400 

� 512 Mb RAM (cache L2 256) 

� Disk subsystem SCSI with two arrays 

� Primary partition for /root files, swap and Domino binaries and /home for notes data both 
on RAID 0 and using the Ext3 filesystem

� UnitedLinux 1.0

� Domino 6.0.1 Server

Client
� IBM Netfinity 3000
� 384 Mb RAM
� PIII 650 MHZ
� Lotus Notes® 6.0.1
� Windows 2000 Professional

We had a 100 Mb LAN and the traffic went through a Cisco 2950 C switch.

We used internal tools to simulate mail user workload with 100 simulated users for 150 
minutes, and the server's notes.ini was unmodified. During these tests, 8,700 mail messages 
were routed or delivered locally.
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Disk space usage
There were 101 mail files created on the test server using a renamed copy of mail6.ntf, the 
standard out-of-the-box mail template for Lotus Domino 6. The size of the template was 
approximately 12 megabytes. 

Table 2   Space used for simple mail file

By simply enabling Single Copy Template on 101 mail files, we saved 1.1 GB of disk space, 
with no visible change to the end-user. A Domino administrator needs to plan only 1 Mb per 
user for each empty mail file, when SCT is enabled, compared to 12 Mb needed per empty 
mail file, when SCT is not enabled.

Figure 13   Examples of file size savings for empty mail files

You can take advantage of disk space savings on any database, not just mail, by enabling 
SCT when you have more than two databases on the same server inheriting from the same 
template. 

Disk load, read/write time
With Domino R5 and the availability of transactional logging (TL), most disk queue 
bottlenecks can be removed by enabling TL on a server.  TL writes data to sequential files on 
a dedicated disk array before committing all transactions to a data array, thereby avoiding 
excessive disk head movement and increasing the disk throughput of your Domino server. 

When you enable SCT on a Domino 6 server, you are only using one file to refer to all design 
elements. Once a database with SCT enabled has been accessed for the first time, the 
requested design note is written to memory (Domino buffer pool). Any user who subsequently 
uses the same design element (for example, opens the Inbox folder) will not force the server 
to read this element from the user's mail file on the disk, but instead, the server will use its 
internal buffer (RAM) to serve it. This means that no disk access is required. 

By virtue of this behavior, you eliminate any contention on the SCT file as all design elements 
will be written to cached memory and retrieved from it.

Windows 2000
The following chart demonstrates the gain in % Disk time on the Windows 2000 platform 
(Figure 14).

Description No SCT SCT enabled Gain

Total disk space 
used

1,19 gigabytes 101 megabytes 1 117 megabytes

Size per mail file 12 megabytes 1 Megabytes 11 megabytes

Number of mail 
files

Disk space used 
with no SCT

Disk space used 
with SCT enabled

Gain

100 1,18 gigabytes 100 megabytes > 1 gigabytes

500 5,86 gigabytes 500 megabytes > 5 gigabytes

1 000 11,72 gigabytes 1 gigabytes > 10 gigabytes

2 000 23,44 gigabytes 2 gigabytes > 21 gigabytes

10 000 117,19 gigabytes 10 gigabytes > 107 gigabytes
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Figure 14   Disk time load during tests for Windows 2000

We can summarize the data as follows in Table 3. 

Table 3   Average disk time on Windows 2000 platform

Enabling SCT gave us a gain of average 35.18% in terms of reduced disk time. If you have 
identified disk bottlenecks, and you do not yet use transactional logging, SCT can provide a 
significant performance boost to your disks. 

Linux
We performed the same test on Domino for a Linux server. 

Without SCT SCT Enabled Benefit

58.41% 37.86% 35.18%
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Figure 15   Disk time load during tests for UnitedLinux 1.0

By enabling SCT on 100 mail files, we showed a gain of ca 18% in terms of % Disk time 
(Figure 15). See the details in the following table. 

Table 4   Average disk time on Linux platform

Figure 0-16   Average % disk time on Linux platform

Comparison of % Disk time on Windows and Linux platforms
Now if we compare this result with the Linux platform with the same test we did on Windows 
2000, you can see that the Domino server on a Linux platform uses less resources in % Disk 
time to accomplish exactly the same tasks on the same hardware. The benefit gained is 
greater on the Windows platform than on Linux, and brings it closer to the load on Linux.

Table 5   Comparison of % disk time on the two platforms

Figure 0-17   Comparison of % disk time 

Without SCT SCT Enabled Benefit

26.59% 21.88% 17.71%

No SCT enabled With SCT enabled Gain

Average %Disk 
time on Windows 
2000

58.41% 37.86% 35.18%

Average %Disk 
read time on Linux

26.59% 21.88% 17.71
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Disk read time
We now look more deeply at the disk time by splitting it into read and write activities.

Windows 2000
Most of the difference with the % Disk time comes from the % Disk read time. Notice the 
difference in % Disk read time. It is significantly lower (see Figure 19) which shows results 
from a test using SCT. The server does not need to read the information each time a design 
note from a user's mail file is accessed for the first time during a user session. 

Figure 18   Detailed results from the disk load test on Domino 6 server without SCT enabled on Win2K
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Figure 19   Detailed results from the disk load test on Domino 6 server with SCT enabled on Win2K

Data on % Disk time statistics can be summarized as shown in Table 6. Notice the gain of 
96.64% in % Disk read time.

Table 6   Average % Disk time on the Windows 2000 platform

Linux
Table 7 shows average % Disk read and write times on the Linux platform.

Table 7   Average % Disk time on the Linux platform

No SCT enabled With SCT enabled Gain

Average %Disk 
time

58.41% 37.86% 35.18%

Average %Disk 
read time

15.78% 0.53% 96.64%

Average %Disk 
write time

42.63% 37.33% 12.43%

No SCT enabled With SCT enabled Gain

Average %Disk 
time

26.59% 21.88% 17.71%
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CPU impact 
Please be aware that using SCT will require more processor time. In order to serve the user 
the requested file, the Domino server uses more CPU cycles to virtualize the design 
elements, rather than simply getting them from the NSF and displaying them.

The server must assemble the design elements, and send pointers to them when a new 
request is received. This action is not necessary if the design elements are stored directly in 
the database, and accounts for the additional CPU cycles when SCT is used.

Windows 2000

Figure 20   comparison chart for % CPU load during tests on Windows 2000

Data can be summarized as follows in Table 8. 

Table 8   CPU load comparison on Windows 2000

Linux
As for Windows 2000, using SCT increases the load in term of required CPU cycles. 
However, the baseline on Linux is at a lower level than for Windows 2000.

Average %Disk 
read time

5.07% 1.18% 76.73%

Average %Disk 
write time

21.52% 20.70% 3.81%

No SCT enabled With SCT enabled Gain

No SCT enabled with SCT enabled Gain

Average CPU 
usage %

19.81 26.86 -35.58%
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Figure 21   Comparison chart for % CPU load during test for UnitedLinux 1.0

The difference between SCT and no SCT is around 24%, as summarized in Table 9. 

Table 9   CPU load comparison on Linux

Comparison of CPU impact on Windows and Linux platforms
Now, if we compare Linux to Windows 2000, the need in CPU cycle is at a lower level to 
perform the exact same load, and the CPU load hit is lower on Linux (Table 10).

Table 10   CPU load comparison on Windows and Linux platforms

As for % Disk time, Linux needs less resources to perform the required tasks. This gap is 
related to savings in % Disk time; as the Linux server requires less disk I/O, it spends less 
time in kernel wait mode freeing up more CPU resources.

Memory used 
As you can see from Figure 22, memory management is more efficient when using SCT. The 
Domino server does not need to store each design element for each database that is going to 

No SCT enabled With SCT enabled Gain

Average CPU 
usage % on Linux

15.92% 19.74% -23.99%

No SCT enabled With SCT enabled Gain

Average CPU 
usage % on 
Windows 2000

19.81% 26.86% -35.58%

Average CPU 
usage % on Linux

15.92% 19.74% -23.99%
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be accessed, but instead re-uses existing design elements that are now retrieved from the 
same source (SCT template) and to be re-assembled by the server (causing it to use more 
CPU cycles as shown in  “CPU impact” on page 19).

Windows 2000

Figure 22   Memory committed in Megabytes on Windows 2000

Linux

Figure 23   Memory committed in megabytes for UnitedLinux 1.0
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This test did not show us major differences in memory usage when enabling SCT; the value 
remains roughly the same in both cases.

Comparing the Linux behavior with Windows 2000 results, Linux allocated more memory 
blocks than Windows 2000. This can be explain by the fact that Linux uses a different method 
to handle its memory management than Windows. In our case, allocation was done by a 
block of 32 megabytes for Linux.

Table 11   Memory usage comparison on Windows and Linux platforms

Summary
Single Copy Template is a powerful feature that can help achieve the following goals: 

� Have one central location to store designs. 

� Reduce the space disk used on a server for the same amount of database used. 

� Optimize your disk subsystem I/O by reducing the global % Disk time, which is a common 
bottleneck (especially the % Read Disk time).

� If you use quota on mail file, by removing template elements, you will allow users to store 
more data without changing quota information.

� Minimal changes are required to your Domino setup, one server can have SCT enabled 
without affecting other servers. SCT is transparent for users and servers.

Table 12   Summary table

No SCT enabled With SCT enabled Gain

Average committed 
memory on 
Windows 2000

339 Mb 333 Mb 1.77%

Average committed 
memory % on 
Linux

372 Mb 372 Mb 0%

Description No SCT SCT enabled Gain

Total disk space 
used

1,19 gigabytes 101 megabytes 1 117 megabytes

Size per mail file 12 megabytes 1 Megabytes 11 megabytes

Average %Disk 
time on Windows 
2000

58.41% 37.86% 35.18%

Average %Disk 
read time on 
Windows 2000

15.78% 0.53% 96.64%

Average %Disk 
write time on 
Windows 2000

42.63% 37.33% 12.43%

Average %Disk 
time on Linux

26.59% 21.88% 17.71%
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Resources
For more information about other new features of Domino 6, refer to the redbook Upgrading to 
Lotus Notes and Domino 6, SG24-6889-00.

For more details on how to run Domino 6 on Linux, refer to the redbook Lotus Domino 6 for 
Linux, SG24-6835-00. 

For more information about performance benefits of Domino 6, refer to the Redpaper 
Upgrading to Domino 6: Performance Benefits, REDP3634. 

For more information about the Linux Ext3 filesystem refer to this URL:

http://www-106.ibm.com®/developerworks/linux/library/l-fs7.htm

The team that wrote this Redpaper
This Redpaper was produced by a team of specialists from around the world working at the 
International Technical Support Organization, Cambridge Center.

Tommi Tulisalo is a Project Leader for the International Technical Support Organization at 
Cambridge, Massachusetts. He manages projects whose objective is to produce redbooks on 
all areas of Lotus software products. Before joining the ITSO in 2001, he was an IT Architect 
for IBM Global Services in Finland, designing solutions for customers, often based on Lotus 
software.

Jean-Noel Koval works as a Senior IT Systems Specialist for IBM Software group in Paris, 
France. He joined Lotus 6 years ago and has been leading IBM’s internal early deployment of 
Notes and Domino 6 for EMEA region. He has been working with early deployment of Notes 
and Domino 6 since 2000. He was also involved in the early deployment of Domino R5 for 

Average %Disk 
read time on Linux

5.07% 1.18% 76.73%

Average %Disk 
write time on Linux

21.52% 20.70% 3.81%

Average CPU 
usage % on 
Windows 2000

19.81% 26.86% -35.58%

Average CPU 
usage % on Linux

15.92% 19.74% -23.99%

Average committed 
memory on 
Windows 2000

339 Mb 333 Mb 1.77%

Average committed 
memory % on 
Linux

372 Mb 372 Mb 0%

Description No SCT SCT enabled Gain
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Lotus EMEA. Jean-Noel’s areas of expertise include Domino administration, infrastructure 
implementation and optimization, with a special interest in performance related information 
and experience on various platforms. He has also been an early adapter for Domino for Linux. 
Jean-Noel can be reached at jnk@fr.ibm.com.
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Notices

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. Consult 
your local IBM representative for information on the products and services currently available in your area. Any 
reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, 
program, or service may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to 
evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. The 
furnishing of this document does not give you any license to these patents. You can send license inquiries, in 
writing, to: 
IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION 
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of 
express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made 
to the information herein; these changes will be incorporated in new editions of the publication. IBM may make 
improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time 
without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any 
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the 
materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring 
any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published 
announcements or other publicly available sources. IBM has not tested those products and cannot confirm the 
accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them 
as completely as possible, the examples include the names of individuals, companies, brands, and products. 
All of these names are fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental. 

COPYRIGHT LICENSE: 
This information contains sample application programs in source language, which illustrates programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs in 
any form without payment to IBM, for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating platform for which the sample 
programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, 
cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and 
distribute these sample programs in any form without payment to IBM for the purposes of developing, using, 
marketing, or distributing application programs conforming to IBM's application programming interfaces. 

Send us your comments in one of the following ways:
� Use the online Contact us review redbook form found at:

ibm.com/redbooks
� Send your comments in an Internet note to:

redbook@us.ibm.com
� Mail your comments to: 
© Copyright IBM Corp. 2003. All rights reserved. i

http://www.redbooks.ibm.com/
http://www.ibm.com/redbooks/
http://www.ibm.com/redbooks/
http://www.redbooks.ibm.com/contacts.html


IBM Corporation, International Technical Support Organization
Dept. HYJ  Mail Station P099
2455 South Road
Poughkeepsie, NY 12601-5400 U.S.A.

Trademarks
The following terms are trademarks of the International Business Machines Corporation in the United States, 
other countries, or both: 

Redbooks(logo) ™
Redbooks™
ibm.com®
iNotes™

Domino™
Domino Designer®
IBM®
Lotus Notes®

Lotus®
Netfinity®
Notes®
Linux®

The following terms are trademarks of other companies:

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United 
States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the 
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both. 

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks owned by SET Secure Electronic 
Transaction LLC.

Other company, product, and service names may be trademarks or service marks of others.

®
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